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I,

AN INTRODUCTION TO USER DISORIENTATION
AND NAVIGATION IN HYPERTEXT

Hjrpertext is a new form of commimication that has been vmder
development since the early 1960s (Nielsen, H3rpertext 41). It is commonly
defined as a group ofindependent text segments called nodes that are connected '
by links. A link is an associative connection that is maintained by the computer.

These links allow the reader to access a node from any other node, which
eliminates the single sequential order that is commonly fotmd in most printed
texts. Because the reader is given a choice of paths through the text, h3rpertext

documents are non-sequential in nature (Nielsen, H3TDertext 1). This non
sequential reading order is probably one of the most important characteristics of
h5rpertext and is simultaneously both an advantage and a disadvantage.

A non-sequential reading order is an advantage because it allows technical
information to be accessed in a way that meets the needs of the audience
(Yoimggren 78). Thus, the same document can provide background information to
novices in the form of "pop up windows" while giving more advanced users the

ability skip the information entirely if they so desire (Brown and Russell 163).
On the other hand, a non-sequential reading order is a disadvantage

because people often become disoriented when they try to find information within

the document. This disorientation occurs when they cannot answer three
questions:

1. Where should I go next?
2. How can I get back to....?

3. Where am I now? (Wright and Lickorish 97)
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This problem with user disorientation was noticed early in hypertext

research by Van Dam when he was working on the H3^ertext Editing System
(889), and he still considered it a serious problem in 1987. His concern about user
disorientation was expressed in his ke5mote address at the Association for
Computing Machinery's Hypertext '87 conference where he mentioned itas an
area that needed further research (894). At the same time in the journal IEEE

Computer. Conklin pointed out the "disorientation problem" as one of the two
major issues that threaten to limit hypertext's usefulness (38).
While the emphasis on the importance of the disorientation problem has
not changed much since 1987, some people have not completely supported this
view. In 1988, Mark Bernstein asserted that in some situations, such as school
assignments, disorientation is not an issue. This assertion was based on his
assumption that school assignments are read by instructors who are so familiar
with the material that they could not get lost. But Bernstein did acknowledge that
user disorientation should be minimized in other situations, such as using

technical manuals or other kinds of scientific or engineering applications of
h5^ertext (Bernstein, Compass 35-6). In 1991, he went beyond this stance to call

the concern about disorientation "misplaced," and he asserted that user
disorientation "is indistinguishable from bad writing" (Bernstein, Deeply 42).

While Bernstein made this point in reference to hypertext in general, his
argument doesn't completely take into consideration the stringent goals of
technical docimientation. These goals include helping the user to find information
quickly and with a minimum of effort (Simpson arid Casey 39). Because the

purpose of these goals is to help people get their own work done by providing
needed information, any problem that disturbs the transfer of knowledge to the
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reader should not be taken lightly. Therefore, research into the creation of aids to
user navigation and the application of these aids is an important part of hypertext
documentation research.

Navigation Aids
In the course of conducting research into user disorientation, many different
types of navigation aids have been invented. The complexity of these aids range
from a simple backtrack mechanism to a complex integration of artificial
intelligence with h3^ertext documents (Carlson 60). The following aids are the
ones that are identified most frequently in the literature on hypertext. They are

(1) backtrack, (2) history, (3) bookmark, (4) guided tour, (5) indexes, and (6)
browsers. The backtrack, history, and bookmark aids are presented first because
they are djmaniie. The actual screens that these aids access can change each

time the hypertext is used. The last three, on the other hand, are static. They are
set up by the author of the h5rpertext and they will always provide access to the
same screens every time the hypertext is used. Because this study examines

browsers, they will be described more completely than the other types of
navigational aids.

Backtrack

The backtrack facility allows the user to jump back to screens that have

been previously visited. It greatly reduces any mental stress caused by
navigation because users know that they can always invoke the backtrack
command to return to an earlier screen. Nielsen considers this to be one of the

most important of the navigation aids. In order to guarantee its usefiilness, he
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recommends that the backtrack should be consistently implemented so that it is

always invoked in the same manner (Nielsen, Hj^ertext 129), Also, there should
not be a limit on the niimber of times that a user can backtrack to the next earlier

screen from the current screen. The optimimi backtrack implementation would
allow the user to retrace his or her path to the starting screen of the document.

The final point about the backtrack facility is that it should always be available to
the user ( Nielsen, Hypertext 129). There should not be any part of the hypertext
from which this aid is inaccessible.

History

A second" way to help the user navigate is the history facility. Like the
backtrack facility, it allows the user to return to nodes that have already been
visited. But unlike the backtrack facility, which forces the user to retrace his or
her path sequentially in the data, the history facility allows the user to pick which
screen he or she wants to see again. There is no need to travel through other

nodes to get to the desired node (Nielsen, Hypertext 129).

Bookmarks

Because hypertext users may become apprehensive about losing
themselves in the doctmient, Mark Bernstein has suggested that a bookmark
might help alleviate that fear (Bookmark, 39). The bookmark facility allows the

hypertext's readers to save a node to a list if they think that they will need to
return to that node later (Nielsen, Hypertext 130). The resulting list would look
much like a history list. The difference is that the contents of the bookmark list

are totally under the control of the hj^ertext user. This control can be a problem
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because users may not always immediately realize that the contents of a node is
relevant and therefore fail to put it on the bookmark list. As a result, they may
have difficvilty finding the node again later (Nielsen, Hypertext 130).

Guided tours

A fourth navigation aid, the guided tour, is very helpful in giving new users
of a hypertext document an overview of its contents. The guided tour is a string of
nodes that has been linked together into a predetermined path through the
hypertext (Nielsen 128). Usually they are created because the author thinks that
they would be beneficial to the readers.
Guided tours haye three advantages. The first advantage is that a single
hjrpertext can contain many guided tours. For example, a h5^ertext on the
history of the space program could contain one guided tour that shows the
development of the rockets used by NASA, a second guided tour that shows the
development of the manned space program, and a third guided tour that explains

the unmanned space program. The second advantage of the guided tour is that

they break large hypertext documents into easily digestible chimks of information
so that the reader is not as likely to be overwhelmed by the mass of information
contained in these hypertexts. The third advantage is that users are not locked

into following the guided tour to its end. They are free to leave the tour and start
navigating the network at any point if they find a compelling subtopic (Nielsen,
H3T)ertext 128).

There is one problem with guided tours. They contradict the basic

philosophy of h5^ertext by organizing this information into a preset reading
sequence (Nielsen, Hypertext 128). But this is not a serious disadvantage if the
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hypertext provides other methods of navigation and allows the guided tour to be
optional.

Indexes

Indexes are very similar to their paper couinterparts. They present an

alphabetized list of ke3nvords that are associated with each topic in the h3^ertext.
The user can click on one of these words and the hypertext will take the user to
the node associated with it (Shneidennan and Kearsley 12). While indexes have
the advantage of enabling users to look up information by using specific terms,
they are limited to the terms that the author used to index the h57pertext
(Shneiderman and Kearsley 12).

Browsers

Browsers are maps of the information area of the hypertext document.
They have been referred to by a number of other names, such as "overview

diagrams" (Nielsen, Hypertext 130), "graphs" (Frisse 881), and "bracket

diagrams" (Martin 41). They show a complete overview of the organization of the
document to the user. The advantage of browsers is that they help users orient
themselves within the document by showing the topics that it contains. As a
result, users can know their own location and understand their own movements

better (Nielsen, Hj^ertext 131). Also, these browsers can be created in a number
of styles.
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Graphic browsers

One style, the graphic browser, portrays the nodes and links as an

organizational diagram (see Appendix A; Example Graphic Browser Screens). The
nodes are portrayed as circles or squares and the links are shown as lines or
arrows extending from one node to another. A problem with the graphic browser is
that its appearance becomes excessively complex when the information space is

large. As a result, the lines showing the links between the nodes quickly become a
mass of tangled spaghetti (Conklin 39). In response to this problem, researchers
have suggested suppressing the display of some nodes and allow only landmark
nodes to be shown on the graph (Bernstein, Compass 39-9). A landmark node is
defined as a special node that is accessible from many other nodes (Nielsen, Art
298).

One way that the node suppression idea can be implemented is the "fisheye
view" graphic browser. In this view, the network of the hypertext is shown in
detail for the nodes that are near to the current node. Then as the nodes get

farther away from the current node, less detail about the network is displayed
(Nielsen, Hypertext 131). A second way to suppress some nodes is to use
browsers that have multiple levels. The lower level would be comprised of many

maps that show a small local region in detail while the upper level would show the
overall structure of the document. In this scheme, m£iny of the links found in the
lower levels would not be represented in the upper level (Nielsen, Art 300).

Because both strategies for creating graphic browsers require manual link editing,
generating browsers without a good knowledge of the contents of the h5^ertext is
not possible (Bernstein, Compass 32).
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Table-of-contents browsers

The other style of browser, the Table-Of-Contents (TOG), resembles a
book's table-of-contents (see Appendix B: Example Table-Of-Contents Browser

Screens). It does not suffer from the problem of excessive complexity as much as
the graphic browser because it does not explicitly show all of the links between the
different nodes in the document. This is an advantage for large texts that would
cause a graphic browser to be very complex. But omitting links is not an
advantage for small texts because their structure is simple enough to be displayed
easily. It also would be easier to create automatically such a browser because it

would only have to show topic headings and not the associative links between the
topics.

Theory of Navigation

While identifying some ofpossible aids for navigation is an important part
of investigating solutions to the disorientation problem, their proper use must be
understood. Also, any meaningful inquiry into determining their proper usage

must have a basis in theory. Otherwise, research efforts become haphazard in
their approach to the problem that is being addressed. One importeint place to

look for a theoretical basis for using navigation aids is in the psychological
research that has examined how people navigate both physical and textual
environments. Once the psychological research is understood, it can then be
applied to addressing the navigation problem.
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Schemas

Everybody in the world use schemas and cognitive maps to represent their
environment. These schemas tell us what to expect about our environment and

the objects foimd in it (McKnight, Dillon, Richardson 67). One example is the
schema for cities. A woman entering Chicago for the first time would expect to
find government buildings and museums because they are contained in her
schema for cities. But she would have no way of knowing how many government

buildings or museums are in Chicago or how to get to them. This shows the
limitation of schemas. They help us to know what kinds of things to expect in an
environment, but they do not have any information about any particular instance
of that environment (McKnight, Dillon, Richardson 68). In order to find the

musemns, the woman would have to have additional detailed knowledge about the
city of Chicago.

Cognitive maps
A fiilly formed cognitive map, on the other hand, provides the detailed

knowledge needed in the above example. It is considered to be a person's mental
representation of the layout of a specific physical environment (McKnight, Dillon,

Richardson 68). Because cognitive maps are formed from previous experience
with a particular environment, they will go through a period of development where

they are incomplete. The development occurs in three stages. The first stage is
characterized by a knowledge of landmarks. The second stage is marked by a
knowledge of routes or route knowledge, in the environment. The third and final

stage of cognitive map development is reached when the person has acquired
survey knowledge of the environment (McKnight, Dillon, Richardson 69).

10

The difference between route knowledge and survey knowledge is that route
knowledge is not as comprehensive as survey knowledge. A person with route

knowledge knows how to travel from A to B. But he won't necessarily know the
best route from A to B. A person with survey knowledge would know what would
be the best route (McKnight, Dillon, Richardson 69). While these models about

schemas and maps are derived from research on navigation in physical
surroimdings, they provide a usefiil perspective on navigation within texts.

Schemas and maps in text navigation
According to McKnight, Dillon, and Richardson, readers form schemas

about documents from their past experiences with them. These schemas tell

what the contents of a particular text should be and how they should be organized.
When people read a new text, they will orient themselves by using textual items
such as indexes, table of contents, and headings as landmarks (McKnight, Dillon,

Richardson 72). So readers of texts develop schema that enable them to gain
landmark knowledge of books. Researchers have not seen a need for investigating

the acquisition of route or survey knowledge of paper documents because most
documents are qmckly available and users do not retrieve information from them

by following a route (McKnight, Dillon, Richardson 73). But for hypertext
documents, studying route or survey knowledge acquisition makes more sense
because the user will travel between a nimiber of screens to find information.

In terms of navigation within online documents or h3^ertext documents,
learning the organization and structure is difficult because these docimients lack

many context cues that are available for readers of paper text. As a resxilt, the

readers are forced to rely more on textual landmarks such as headings. Research
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into this area has found that people who use non-hypertext online documents

seem to leeim landmark knowledge first and route knowledge second (McKnight,
Dillon, Richardson 78). This phenomenon was also found in two studies by Canter
et. al.. In the first study. Canter et. al. found that novice users preferred to use a

search strategy that took advantage of landmarks in the online text. In the
second study, they found that users were more successful in navigating the text
by using a search strategy that took advantage of signposting (Canter et al. 256).
Later studies have tried to extend these findings to h3rpertext documents. These
studies found that subjects seem to develop landmark knowledge of hypertext
documents but more studies measuring route or survey knowledge are needed
(McKnight, DiUon, Richardson 79).

Context

Providing an adequate amoimt of context to readers of hypertext

docimients is much more difficult than for paper documents. The main reason is

that h3T)ertext documents often lack the context cues that paper docimients

have. Different types of texts, such as books and newspapers, have many
different visual cues that help to establish reader expectations (McKnight, Dillon,
and Richardson 70) (Nielsen, Art 299). For example, books and newspapers have
characteristic differences in their physical appearance. Books tend to be boimd
while newspapers tend to be imbound. Books have smaller page sizes than
newspapers and both types of documents tend to have unlike layouts. But when

information is put online, all of these physical context cues are lost, Nielsen
addressed this problem by considering two different kinds of context; context-inthe-large, and context-in-the-small.
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Context-in-the-large is the overall sense of location that a user of a
document feels (Nielsen, Art 304). Users with a good sense of context-in-the-large
know their location within the information space and the way to the information
that they need. In other words, they may be said to have route or survey

knowledge of a document. Context-in-the-small is the knowledge of how the
information on the screen is related to the svirrounding text (Nielsen, Art 304).

This is a problem for users who are navigating hypertexts in which the nodes are
larger than the available screen size. The users end up scrolling back to other
sections of the text in order to better imderstand what is currently on the screen.
Another place in the document where a reader can have a problem with contextin-the-small is with imderstanding how a link point relates to the information in
the destination node. This can be alleviated by placing links within the text such
that the text will naturally supply context for the link point (Shneiderman and
Koved 312).

Schemas, cognitive maps and context

For users of h3?pertext documents to have a good sense of context, they
need to be able to develop a cognitive map of the document. Using a schema that
matches the t3^e of text is a good starting point. But the vinique organizational

structures of h3rpertext may not lend themselves to this. In the case of hypertext,
schemas may not be useful because h3rpertext documents tend to use unique

organizational structures (McKnight, Dillon, Richardson 76). Any schema that
could be applied to all hypertexts would be too general to be useful in developing a
cognitive map. Such a schema would allow people to expect independent nodes of

information and links that allow travel between nodes (McKnight, Dillon,
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Richardson 76). So in fact, the multiple structures possible with hypertext will
make the user's development of a schema for the text more complicated.
It has also been found that when people approach an online or hypertext

document for the first time, they try to apply schemas from similar experiences to

the present situation, even if the application of the schema resulted in navigation
strategies that do not make efficient use of the navigation aids in the document.

For example, a study by Marchionini and Shneiderman found that students used
an index facility in a hypertext docimient instead of using embedded menus, even
though embedded menus provided a more efficient means of navigation
(Marchionini and Shneiderman 75). Marchionini and Shneiderman attribute this

finding to the level of expertise of the users. In other words, the subjects chose to
reduce their cognitive load by using strategies that £ire modeled on existing paper
based strategies (Marchionini and Shneiderman 76).

Metaphors for navigation
Metaphors provide a way for users to quickly create a schema for learning

a new environment by borrowing from a known environment (Simpson & Casey
52). They are often used for aiding novices' comprehension (McKnight, Dillon,
Richardson 81). The two most common metaphors for navigation are the concept
of traveling through information and "book emulation" (McKnight, Dillon,
Richardson 82). In the navigation metaphor the text is seen as a space that must

be traversed. Researchers tend to use this metaphor most frequently both for
theoretical speculations and as the basis for their studies (McKnight, Dillon,
Richardson 83).
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Using the spatial metaphor provides a new viewpoint that might produce
some important insights into describing user navigation of hypertext. For
example, Canter, Rivers and Storrs exEuninedthe navigation patterns of database
users to see if they could create a quantitative index that described user
navigation (94). This index involved such measures as "Loopiness," and
"Pathiness" in the users' navigational patterns (Canter, Rivers, and Storrs 95).

Another group of researchers, Hammond and Allinson, investigated the idea of the
guided tour as a navigation aid (Hammond and Allinson,Travels 270). They saw
the guided tour as being well suited for use with the spatial metaphor. Other
navigation aids that are well suited for use with the spatial metaphor are the
backtrack facility, the history facility, and the browser.

The second metaphor, "book emulation," is considered to be useful for
novice users because it uses navigation knowledge derived from experience with
books. This experience can be best utilized by using navigation aids like the
bookmark facility and indexes that have foundations within the "book emulation"
metaphor. In fact, the authors using this metaphor can go as far as actually

showing an image of the book on the screen (McKnight, Dillon, Richardson 82).
Not all researchers are enthusiastic about the book metaphor. Nielsen thinks
that using such a metaphor will limit the conceptual model to the users of the
document. Also, he felt that its use is limited to "walk-up-and-use situations"

where there is not an opportunity to leam new skills (Nielsen, Art 300). Because
of objections such as these, the "book emulation" metaphor probably is less widely
used than the navigation metaphor.

One final point should be made about these two metaphors. There is no

reason that h3T)ertext authors can't mix metaphors with respect to navigation

15

aids. For example, the browser aid may work well with the navigation metaphor,
but its use is not restricted to those documents that make use of that metaphor.

It would work just as well with documents that use the "book metaphor."

Studies of Navigation Effectiveness
Because researchers of navigation effectiveness have taken several
approaches, their studies tend to make three kinds of comparisons: (1) paper
documents versus hypertext documents, (2) one kind of navigation aid versus
another kind of navigation aid, and (3) one implementation of a navigation aid

versus another implementation of the same navigation aid. One problem with
these studies is that their results tend to be contradictory.

Paper vs. hypertext

The comparisons between paper and hypertext documents used technical
information as the subject matter. In Rubens' study, he took a software manual
and converted it into hypertext. The subjects were asked to perform tasks that

required them to integrate information from different screens. Rubens found that
converting the manual into h5^ertext without adjusting it into a stiitable format

produced docimients that were harder to use than their paper counterparts
(Rubens 38). The performance difference was expressed in longer search times
and less accurate responses to questions. One reason for the hypertext's weaker
performance was found in the lack of cohesive devices such as indirect references

to previous material that were present in the paper document (Rubens 39). While

they work for linear material where the access is instantaneous, these devices
only increase the amotmt of link traversals.
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A second study by Egan et. al. found almost opposite results from Rubens'
study. These researchers put a statistics manual into a computer environment in
which the users had access to the data through indexing and a fisheye table of

contents (Egan et. al. 205). The indexing and the fisheye table of contents were
used for navigation throughout the superbook docimient. They fovmd that the

computer version of his manual was superior to the paper version of the manual
in terms of speed and accuracy of answering the questions in the study (Egan et

al. 209). They also found that the indexing facility provided less help for the users
when they were provided s)mon3nns than when they had the actual words used by
the author. As a result, they concluded that knowledge of the structure of the

document wag less necessary than the knowledge of the words used by the author
(Egan et. al. 209).

Another study that indirectly contradicted Rubens' findings was performed
by Barfield, Haselkom, and Wheatbrook. They compared a HyperCard stack
version and a paper version of the Hj^erCard user manual. In their study, they
asked subjects to perform simple and complex tasks using the information within

the manuals. They found that while subjects using the paper manual were able to
find the information for simple tasks faster than with the online hj^pertext, the

people using the hypertext were able to complete their tasks more quickly when
the tasks became complex (Barfield, Haselkom, and Wheatbrook). This finding is
in line with Horton's recommendation for not using hypertext for simple
information retrieval (Horton, 308).

As can be seen from the examination of the previous studies, there is no
clear consensus concerning paper versus online comparisons. Each study in some
way contradicts the other. The subjects performed worse on complex tasks for
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Rubens but not for Barfield, Haselkom, and Wheatbrook. Also, Egan et al.'s

subjects were able to perform better on simple retrieval tasks than Barfield,
Haselkom, and Wheatbrook's subjects. These contradictions may be attributed
to differences in the docxmients writing and use of navigation aids and not to the
online vs. paper variable. Therefore, perhaps a change in the focus of inquiry
should change from comparisons of the paper and h3^ertext formats to

comparisons of navigation aids might be more finaitful.

Comparisons between different kinds of aids
Hammond and AUinson provide most of the work that has been done in
comparing the usefulness of different navigation aids. Their studies evaluate aids

that use the navigation metaphor instead of the book metaphor. The aids that

they have examined are a tour facility, an index facility, and a map facility. Their
first investigation was a descriptive study in which they examined the navigation
behaviors of their subjects in a large hjrpertext document (350 screens). They
found that out of their group of 42 subjects, 91% of their subjects used the tour

facility, 79% of their subjects used the index facility, and 74% of their subjects
used the the map. As can be seen by these percentages, most of the students
used all three of the aids (Hammond and AUinson, Travels 272).

After they had examined the data from the first study, they performed an
experimental study in which these three aids were compared (Hammond and
AUinson, Extending 297). One important difference between the two is that the

second study's hypertext document contained only 39 screens. This is a much

smaller hypertext document than the 350 screens of the first study. As a result,
the students are probably not as likely to get lost in it. Hammond and AUinson
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found that when each navigation aid was provided alone, the tour facility was

responsible for the highest percentage of screen traversals (49%) followed by the
map (31%) and the index (23%) (Hammond and Allinson,Extending 297). When all
of the navigation aids were provided to the subjects, then the usage of each aid
was determined by the tjrpe of task that the user had to accomplish. The tour
was used the most for the exploratory task, while the map and index were used the
most for the directed task (Hammond and Allinson, Extending 298). All of their
subjects had an equal accuracy rate regardless of the navigation aid that they
used (Hammond and Allinson, Extending 300). They concluded that the type of
task does affect the use of navigation aids, and that tours help the most with
exploratory tasks while the map and index help the most with directed tasks
(Hammond and Allinson, Extending 302).

Overall, there is a strong level of agreement between the the two studies.
Both have indicated that when the users are exploring the docvmient, they will use
tours the most. The disagreement lies in the different ordering for the index and
the map between the studies. This difference may be due to the different level of

complexity between the two documents. The map may have been more confusing

for the people in the first study who used the larger hypertext document than for
the people in the second study who used a smsdler document.

Implementations of the same aid

While studies like the one performed by Hammond and Allinson may help
choose the best type of aid for a given situation, they do not provide any insight
into how the stylistic differences between versions of the same aid will affect the
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users ability to navigate. Even though there is a need for studies that examine
the effectiveness of different versions of the same type of aid, few are being done.

Comparisons of structure

There hasn't been much work on establishing the role of structure on

navigation. One study by Edwards and Hardman attempted to show that people

do biaild cognitive maps of online documents. They took three groups of subjects
and asked them to navigate a hypertext document. Each group had its own
docimient with a slightly different structure, but the actual contents were
identical. The structures that they compsired were a hierarchy, a mixed
hierarchy, and an index structure. The hierarchy organized the topics into
subordinate and superordinate relationships (see Figure 1).

Figure 1. The hierarchy structure
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The mixed hierarchy contained both the hierarchy and the index structure
in the same text (see Figure 2). The index structure had all nodes linked to a
central node without being linked to each other (Edwards and Hardman 108) (see
Figxire 3), They hypothesized that the subjects would find the structure of the
hierarchy to be the easiest of the three to comprehend. Therefore, the people
using this structure should have the highest level of performance and they should
have the most accurate imderstanding of the text's structure. Edwards and
Hardman also hjrpothesized that the subjects should find the mixed structure to
be the most difficult to understand and that the subjects using it should do worse
than the other groups (113-4).

Figure 2. The index structure
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Figure 3. The mixed structiire

Edwards and Hardman found that their hypotheses were basically true.
The people who were in the hierarchy condition showed the greatest improvement

in their times. By the end of the study, they were performing better than the

other groups (Edwards and Hardman 117). Also, the people who were in the
hierarchy demonstrated the best imderstanding of the structure of the document
(Edwards and Hardman 117-119). The power of hierarchical arrangements of

information could be seen in how some people in the index condition built a map
that followed the content hierarchy of the document instead of the link structure.

From these results, they concluded that simple hierarchies do the best job of
enabling people to make internal cognitive maps of docximents and that mixed
structures interfere with forming this map (Edwards and Hardman 123).
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Comparisons of browsers

A second group of studies has concentrated on comparisons of hypertext
browsers or closely related issues.

One study by Egido and Patterson is a verbal vs pictorial comparison for a
hierarchical hypermedia browser. They hypothesized that a picture combined
with a label should aid navigation within a pictorial database better than just

pictures or labels alone (Egido and Patterson 127). They found that pictorial data
does help the user navigate the database. When the pictures were used to
illustrate labels, the subjects performed the best (Egido and Patterson 131). But

the researchers raise the point that verbal descriptions of the labels might have
been just as helpful to the user as the pictures (Egido and Patterson 132).

McKnight, Dillon, and Richardson have reported a "series of studies that
examined the effectiveness of a hierarchical list against an alphabetical list.
Simpson foimd that a hierarchical list is more effective as a navigational aid than
an alphabetical list. Also, she found that a graphical contents list provided more
help than a text based Ust (McKnight, Dillon, and Richardson 80-1).

Questions Raised by Previous Work

When we examine the research that compares the different t3rpes of

browsers, it seems that the graphic browser would be superior to a verbal style of
browser such as the table-of-contents style. But a closer inspection raises a few
questions about the studies. The first question revolves aroimd the verbal list

that Simpson was comparing the graphic browser against. Was the verbal list a
hierarchical list or merely an alphabetical list? Also, how big was her document?
According to McKnight, Dillon and Richardson she used a relatively small text
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(82). Would her resxilts be replicable with a map for a larger text that would have
a more complex graphic browser?

Other questions revolve around the experience level of the subjects used in
the study. Many researchers, like Edwards and Hardman or Barfield, Haselkom,
and Wheatbrook, put their subjects through a training period before starting the
study. By giving them training, the researchers promoted the development of a
schema for h3^ertext that prevented the participants from being novices. So are

these results generalizable to people who haven't seen hypertext before? This is
an important question because most people currently have very little experience
with hypertext.

Purpose of the Current Study

The current study was developed in order to explore the effect that two
different types of browsers have on novice users of hypertext. In this comparison
of the table-of-contents (TOG) style of browser and the graphic style of browser, it
is hypothesized that that the TOG style will be more effective in aiding novice
users of hypertext for two reasons.
The first reason is that there would be a transfer of training effect with the

TOG style of browser. The transfer of training effect occurs when people apply
knowledge from one system to another system (Simpson & Casey 50). Because
of their experience with this structure in print, the subjects would already have a

schema for using a TOG type of browser. Thus, they would find the TOG type of
browser easier to use.

The second reason is that the TOG style should do a better job of helping
the user develop an accurate cognitive model of the reference text because it
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shows the document's topical hierarchy more clearly. This clearer presentation of
the hierarchy was achieved by excluding all representation of the document's links
in the browser and by displaying the nodes* headings in a hierarchy. Support for
the position that the representation of links should be reduced in browsers comes
from Conklin and the study by Edwards and Hardman. Conklin reported that that
graphic browsers become complex when the hypertext document becomes very

large because of the large ntmaber of links that they display (Conklin 39). Also,
Edwards and Hardman's study showed that subject's performance declined when
a document's structiire became too complex because of a large nimaber of links
(117).

Variables used in the study
Variables must be selected that efficiently tests the following hypothesis:
for novice users who need to perform directed tasks, the TOC style of browser

makes navigation within a hypertext easier than a graphic style of browser. It is
important that the variables used to measure the subject's performance
accurately reflect the document's ease of use. After examining the literature and

considering the needs of this particular study, the following variables were chosen:
1. The number of screens visited for each question.
2. The total nimiber of screens visited for the session.

3. The amoimt of time taken to find the answer to the question.

4. The amount of time taken to find the answer to all of the questions.
5. The number of times the browser was used.

6. The accuracy of the answers.
7. The screen id and name.
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Each of these variables measures a slightly different aspect of the

students* performance that is affected by the hypertext documents' ease of use.
The first and second variables examine the ease with which information is

accessed. The larger the number of screens, the more Hkely that the subjects*had

difficulty finding the information that they wanted. This interpretation of these
variables is implicitly supported by Edwards and Hardman's assertion that those
people with more complete maps of the information structure of the hj^ertext
would search through a smaller number of screens than if their map was

incomplete (113). Also, a large screen coimt is imdesirable because most users
are trying to find information with a minimum amount of effort. This is because
most users of online reference documentation need to answer a specific question
about commands or operating procedures (Horton 36). They don't want to browse
through the manuals. Usually, they want the answer in the shortest amount of
time so they can get back to other work (Simpson & Casey 38). Therefore, they

will want to expend a minimum amount of effort to find the information, and
searching through a large number of screens could be interpreted as an activity
that requires a lot of effort.
The third and fourth variables, the amoimt of time needed to find the
answers, takes a sHghtly different view of the amount of effort needed to find the

infonnation. The greater the amount of time needed to find the required
information the greater the likelihood that they were lost, Rubens felt in his
comparison of online docxmientation vs. paper that the shorter search time
indicates a more efficient search (38). Other researchers have used the same

26

interpretation ofthis variable (Egan et al. 39) (Canter et al. 255) (Edwards and
Hardman 113)

The fifth variable, the number of times the browser was used, is important

in determining if the users took advantage of these aids. If Hammond & AUinson's
logic is to be used for this variable, then the browser with the greatest use could be
considered to be the most useful (298).

The sixth variable would help in determining if the users actually found the

information that they needed. This variable is probably the most important of the
performance variables because a technical document's ability to convey

information accurately to a reader is critical to its effectiveness. While the sixth
variable is affected by the t3T)e of browser used, it is also affected by other factors
in the screen. Some of these include the style of writing, the readability of the text,

and the passive screen based orientation factors. Potentially, these factors
present a threat to the study by allowing confoimding explanations, but they were
controlled because only the browser was changed between the two hypertexts.
The seventh variable, the screen IDs and names, was recorded more as a

way to double check the other variables and to determine the actual path that
was taken by the users.

Expected results

If the TOC browser is superior at aiding the novice user in navigating a
hypertext document, the following relationships between the two browsers wotdd
be expected to occur.
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1. The students using the TOC style of browser should
traverse fewer screens than the students using the graphic
style of browser.

2. The students using the TOC browser should take less time
to answer their questions than the students using the
graphic style of browser.

3. The accuracy of the responses given by TOC browser
groups should be greater than the accuracy of the
responses given by graphic browser groups in answering
their questions.
In summary, the purpose of this study was to compare two types of
browsers. The study attempted to determine whether novice users of a hypertext

software user manual found a TOC style of browser to be easier to use than a
graphic style of browser when they were asked to perform directed tasks. The
TOC was expected to be superior to the graphic style because of the transfer
effect from print books and because the TOC style shoxild be less confusing to

read. In the upcoming chapters, the following points will be discussed: the
methodology used to compare the two browsers, the data that was collected, and
the ramifications of this data.
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II.

METHOD

Because the study attempts to determine whether novice users of a
hjrpertext software user manual found a TOC style of browser to be easier to use

than a graphic style of browser when they were asked to perform directed tasks, it
used the quasi-experiment as the basic investigative method. The quasi-

experiment was selected because it provides the researcher with the ability to
establish cause and effect relationships between a treatment and its results. It
differs from the true experiment in that the subjects are not randomly assigned to

the main groups, the equality of the main groups are determined via a pretest, and
the research design must account for threats to internal validity (Lauer & Asher
179).

The basic procedure for performing this study consisted of three steps. The
first step was to develop the written materials for the study. These materials
included two hypertext versions of the software docimientation, the pre-test, and
the questions for the directed task. The two versions of the docvmientation were

developed fi:om the printed manual of a Macintosh drawing program. These two
hypertexts differed only in the type of browsers that they used. The second step
was to ask two classes of upper level technical writing students to do the pretest

and to perform a directed task using these hypertext docimients. To do the
pretest, the students had to answer a survey. Their answers to the questions
were used to establish the experience level of the two classes. The directed task
involved basic information retrieval. The students were asked to answer ten

questions using information that they found in the hypertext documents. One half
of each class was randomly assigned to one of the browsers so that there were two

groups using the graphic browser and two groups using the TOC browser. As the
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students worked on the directed task, the computer recorded their performance in
terms of the variables that were described earlier. The third step was to analyze
the data in order to evaluate the effectiveness of the browsers.

The following sections explain the basic procedure in greater detail. They
discuss the experimental subjects, the materials used in the study, the data
collection procedure, the data analysis methods used, and the threats to the
study's validity.

Subjects

The subjects were members of two sections of an upper-level technical
writing course. The sections were computer intensive, i.e., the students did all of
their class work on the computer. They did their in-class assignments on the
computer, their out of class assignments on the computer, and their class
discussions on the computer. The number of students in each of the classes was
20 and 22 respectively. The subjects cannot be considered to be representative of
the audience of the original drawing program documentation because students in
this course tend to come primarily from the scientific and technical majors. In
contrast, many users of this drawing program are not limited to these

backgrounds: they come from non-technical areas as well. So the subject sample
is limited by a lack of individuals that represent the non-technical, artistic user.

While many of the students didn't know that the course was computer
intensive when they registered, others did know. This knowledge increased the

likelihood that some of the subjects in the sample were self-selected and their
presence was not the result of a random sampling of students taking this
particular upper level technical writing course. The self-selection woiild occur
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because some of the students would take the class because it was computer

intensive, while others would leave the class because it was computer intensive.

The major criteria in selecting the subjects were the subjects' availability
and their general experience with computers. I wanted novice hypertext users,
not novice computer users. These two classes filled both criteria. Most of the
students had worked with microcomputers before this class and everyone in the
class had ten weeks of experience of using Macintosh computers before taking

part in the study. Because they had previous computer experience, any difficulty
that they experienced might be more attributable to their use of the hypertext and
less to their experience with manipulating the computer itself.

Materials

The materials used in the study consisted of (1) the pretest, (2) the
hypertext documents, (3) the task questions, (4) the procedural instructions and
(5) the exit letter that provided the students with a way to find out what the study
was about.

The pretest

The pretest was a survey designed to measure the two classes' equality in
terms of the variables used to measure the student's ability to navigate the

hj^ertext. This measurement was done by examining four aspects of the
subjects' backgroxmd: general demographic information, their previous experience

with the Macintosh computer and the H3T)erCard authoring environment, their
previous hypertext experience, and their previous experience with the software
package that is described in the hypertexts (see Appendix C: The Pretest). By
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asking about the students' prior computer experience, their basic computer skill
level could be established. This was important because their skills with the basic

system affected how quickly and easily they could traverse the hypertext as they
looked for answers to the task questions. If they had an equal level of experience,

then they should have manipulated the mechanics of the interface equally well.
Thus their average speed in answering the questions should not have been
affected by their mastery of the computer.

Along with measuring the equality of the two classes in terms of the
performance measures, the pretest asked if the subject was a native English

speaker. This question was used to determine if the presence of non-native
English speakers would introduce error into the study. So the pre-test examines
the most critical areas that might introduce systematic error into the study.

The hypertext documents
Except for their browsers, the two h5^ertexts that were developed from the

drawing program's documentation were identical. Everything from the
information contained in each hj^^ertext to the basic layout of the screen, to the
actual structure of the docimients, to the documents* interaction with the user

was identical. This identical structure was achieved through developing one
document and then making a copy of it. The copy then had the second browser
integrated into it. Since the only area where the two h5TDertexts weren't identical

was in their browsers, any difference in the performance of their users probably
could be attributed to these browsers.

The information contained within each of the hypertexts was an excerpt of
a manual for a common drawing program. The drawing program manual was
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selected for a number of reasons. First, it was already structured in a modular
fashion: the manual was organized into small chunks, ofinformation that were

independent of each other. This modularity of the information in the manual made
it an excellent candidate for conversion to a h3^ertext format. The hypertexts
that were created from this msinual contained approximately 119 screens of

information, which was organized into 70 nodes with an average node size of 1.7
screens.

The layout of the screens was designed to provide the user with as much
contextual information as possible. For example, the the top of the screen held
both the topic and subtopic headings, so the user could always tell which topic he
or she was reading (see Appendix D: Example Data Screens). Also, a number in
the upper right comer of the screen indicated the number of screens ofinformation
that were in the current node. This information was important for the user since
the number of screens in each node ranged from one to three. The multi-screen
node design was used because of the relatively small amount of information that

could be put into a single screen. The controls of the two h5^ertexts were
identical. Both documents allowed for quitting, for accessing the browser, and for
sequentially traversing screens within and between the nodes. Also, there was a
minimum of five and a maximimi of fourteen links on each screen.

The structure of the hj^Dertext documents was a modified hierarchy. This
structure was used because it most accurately reflected the organization of the

original user manual, while allowing the user to jump directly to associated areas.
These links complicated navigating through the document some, but they also

provided readers with the ability to access other relevant poiiions of the text
without having to traverse the hierarchy.
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The task questions

The, questions that the student were to answer were presented in a
seperate section of the hypertexts and the student's responses to these questions
were recorded by the h3^ertexts. The questions were designed so that no one area
of the h5^ertext would be visited more often than any other areas. Also, the task

questions made direct references to the topic headings for each node (see Appendix
E: The Directed Task Questions). The questions contained some word or phrase
from the name of the screen that contained the answer to the question. This
would increase the student's chsinces of recognizing the screen that he or she

needed. To make the analysis of the students' answers easier, the answers to the
questions were framed in a multiple choice format. Each question had a choice for
skipping the question so the students could give up if they couldn't find or recognize
the answer in the hjrpertext.

The procedural instructions

Because both the survey and the hypertext documents were on the

computer, the procedural instructions were provided in paper format. The
procedural instructions told the students how to find the hypertexts and how to
use them (see Appendix F: The Procedural Instructions). The procedural

instructions also gave the students an ID number, which was used to organize the
data during the data collection and the analysis stages of the study. A final
feature of the procedural instructions was that they had a help section which
explained the different controls in the hypertext. Because only the most essential
information was given in the procedural document, its length was limited to fo\ir
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pages. It was important to make this document as clear and as complete as
possible so that the users wouldn't have any trouble understanding their task.

The exit letter

The exit letter explained the purpose of the study and the variables that
were examined (see Appendix G: The Exit Letter). This letter was placed in the

students' class files on the computer after both classes had participated in the
study. This prevented the people in one class from contaminating the next class
by telling them about the letter's contents. Besides explaining the variables that
the computer measured, the exit letter also revealed the answers to the questions.

Procedure

As part of the preparations for the study, the students were assigned an ID

number. This number was used to identify the data set without revealing the real
name of the student. After they were given this nvmaber, they were randomly
assigned to one of the browser types. The assignment was done by creating two

random lists of the ID nimibers with a computer. One list was created for each
class and was then divided in half. The first half of each list was assigned to the

TOC style of browser and the second half of each list was assigned to the graphic
style of browser.

When the students entered the lab, they were given the procedural

instructions handout that told them how to answer the questions in the pretest
and how to use the hypertexts. Before they were allowed to begin, they were read

a prepared statement that provided background information. Then they were
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allowed to ask for clarifications. After that, they could not ask any questions
related to the directed task.

The packet instructed the students to fill out the questionnaire first, then it
instructed them on how to open the hypertexts that were used for the directed
task. After the students opened the hypertext, the h3rpertext asked for their ID

number. After they entered their ID mmiber, the hypertext opened a file with that
ntimber as part of the file's name. The file was placed in a data folder that was
located in the same folder as the hypertext docimient. As the user traveled firom

screen to screen, the hypertext wrote both the screen's name and ID to the file
that it created. In this way it kept track of the screens that the reader traversed.
After the hypertext created the data file, it displayed to the students the
instructions for answering the ten directed task questions that were presented by

the h5^ertexts. When the students finished reading the instructions, the
h3T)ertext presented the first question to them and recorded the current time to its
data file. At this point, the students were firee to navigate the hypertext in search
for the answer. Once they found the answer, they could come back to the question

screen and select the correct answer. The program would then go to the next
question after the students indicated that they had answered the question. The
interaction continued in this fashion \mtil the last question was answered. Then
the computer wrote the the total number of data and browser screens that the

students traversed to the data file and closed the file. After the subjects finished

answering the questions, they were allowed to leave the laboratory.
The following variables were measured by this procedure: the time at which
a question was presented to the subject, the time at which the subject either
answered the question or gave up, the name and ID of each screen that the user
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read, the total niomber of screens that the user read, the total number of browser
screens that the user read, and the student's answer to each question.

Threats to Internal Validity

The data collection procedure was developed to minimize as many threats

to internal validity as possible. The threat of instrumentation was minimized by
having the computer measure the different variables under study. Because only a
single entity was making the measiirements, inter-rater reliability was not a
factor.

The threat of testing was addressed by testing the students only one time
on the hypertext. The pretest was a different tj^je of test from the one used in the
hj^ertext. Therefore, the subject's performance with the hypertext was not

confoimded by any practice on the pretest. Testing the groups at one time also
reduced the threat of mortality as well as regression towards the mean. The
subjects were less likely to quit in the middle of the study if there were only one
measurement session. Maturation, history and instability were also controlled by

holding the pretest and the quasi-experiment very close to each other in time.

This limited the amount of change the students experienced dining the study.
The only other possible threat to internal validity was diffusion caused by
the classes interacting as one class left and the other one entered the test site.

However, it was not likely that people from the separate classes knew each other.
Also, they did not have enough time to discuss the study beyond a few
inconsequential words.

In terms of external threats to validity, the Hawthorne Effect was
minimized by having the computer monitor the student's activities. This reduced
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their awareness of the test itself. The awareness coxild not be eliminated because

the experimentad situation could not be hidden. Since all of the internal threats to
validity have been controlled by the experimental design, any interactions
between them were minimized.

Data Analysis

After the subjects completed their directed task sessions, the means and
standard deviations were calculated for all of the variables. These variables were

checked for normalcy and then were subjected to a two way ANOVA. The
ANOVA was performed on the variables to test for statistical significance, and
the time and screen variables were checked for a correlation.
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III.

RESULTS

Because this research is a comparative study that attempts to determine

whether novice users of a hypertext software user manual foimd a graphic style of
browser to be easier to use than a TOC style of browser, the equaHty of the two
classes must be established by the pretest before any meaningful comparisons
can be made from the directed task's data. This section will summarize the

pretest results before reporting on the directed task's results. The data focuses on
the results which allow the two classes to be compared in terms of their general
demographics and in terms of their computer, hypertext, and drawing software
experience.

Profile Data

All students present for the experiment completed a profile: 20 students for
one class and 21 students for the other class. The student's responses indicated

that they were predominantly imdergraduate upperclassmen (juniors or seniors).
Only two people in the group, one sophomore and one graduate student, were not
undergraduate upperclassmen (see Table 1). The classes were also predominantly

male, five out of a total of 41 students were women. The educational background
of the majority of these students was science related: twenty-seven students

were in a hard science or engineering related field, six were in a biological science
field, three were in a social science field, three were in economics, one was in
physical education, and one was in English. Ten students were not native English
speakers (see Table 1).
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Table 1 Results of the pretest

Characteristic

Class 1

Class 2

Total

Sex

Male
Female

19

19

38

3

2

5

Classification
Graduate

0

1
18

1
34

Senior

16

Junior

4

1

5

Sophmore

0

1

1

Freshman

0

0

0

Biological Science

3

3

6

Economics

0

3

3

13

14

27

English

1

0

1

Social Science

2

1

3

Physical Education

1

0

1

17

14

31

3

7

10

Major Area

'

Engineering or
Physical Science

English Language Skills
Native Speaker
Non^Native Speaker

40

It was important that the subjects were relatively equal in terms of
experience with computers, with hypertext, and with the manual's drawing

progTEim because experiences in these areas would affect the performance of the
subjects. The profile showed that the students had similar computer experience.
All of the students had at least ten weeks of experience of using the Macintosh

computer for their writing assignments, and both classes had an approximately
equal number of people who had used microcomputers prior to that semester, 18
in first class and 17 in the second class.

The two classes also had very similar experience in terms of the type of
computers they had used before the semester in which they took part in the
study. The specific computer models that were listed in the survey were selected
because they either had a graphic interface like the Macintosh or because they
were a common machine (see Table 2). The Macintosh, Amiga, and Atari

microcomputers all use a very similar windowing interface. Any previous
experience with them would transfer directly to the Macintosh computers used in
the study. The MS-DOS and Apple II categories were included in the survey
because they are common microcomputers. While their interfaces are different
fi:om the Macintosh, it was felt that they would provide a more complete view of
the subjects.
The profile results of the first class indicate that 14 people had previous

Macintosh experience, 11 people had previous MS-DOS experience, two people had
previous Amiga experience, one person had previous Atari experience, and seven

people had Apple II experience. Obviously, there were a number of people in this
class who had experience with more than one type of microcomputer. The results
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Table 2. Results of the pretest

Characteristic

Class 1

Class 2

Total

Previous computer experience
Yes

18

17

35

2

4

6

8

7

15

14

13

27

Programming

7

7

14

Other

3

4

7

No

Primary Microcomputer Use

Spreadsheet
Word Processing

Type of Microcomputer Used
Macintosh

14

12

26

MS-DOS

11

14

25

Amiga

2

2

4

Atari ST

1

0

1

Apple II

g

7

16

Yes

3

3

6

No

14

14

28

3

4

7

3

5

8

Previous Hypertext Experience

Don't Know

Drawing Program Experience
Yes

42

of the second class indicate that 12 people had Macintosh experience, 14 people

had MS-DOS experience, two people had Amiga experience, and seven people had

Apple II experience (see Table 2). Like the first class, this second one also had a
niomber of people who were familiar with more than one type of microcomputer.

The profile also showedthat the two classes were similar in terms of the
their experience with hypertext. Three people from class number one had used
hypertext before, 14 people from class number one never used hjrpertext before,
and three people from the class didn't know if they had used h3^ertext before or
not. Three people from class number two had used hypertext, 14 people from
class number two had never used hj^jertext before, and fo\ir people didn't know if
they had used hypertext before (see Table 2).

The classes also showed that they had a similar level of experience with the
drawing program. Seventeen people in class number one had not used the drawing
program before while 15 people in class nimiber 2 had not used the drawing
program before.

Directed Task Data

Because a large nimaber of questions were not completed, the screen count

per question and time count per question variables were not distributed normally.
Therefore further analysis was restricted to the following variables: (1) the total
number of screens, (2) the total time taken to answer the questions, (3) the
accuracy of the answers, and (4) the total number of browser screens. The first
three variables were already distributed normally so they don't need any further
manipulation. The logarithm of the last variable, total nimiber of browser
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screens, was used to establish a normal distribution. Then a two-way ANOVA
was performed on these four variables as a test for statistical significance.

While there were differences in how the classes performed on the four major
variables (nximber of screens traversed, time taken to answer the questions,

number of browser screens traversed, and accuracy of the answers), a two way
ANOVA found that none of these differences were statistically significant at a p
value of 0.20. It is important to note that a p value of 0.20 is the maximum value

that many researchers will accept for tests of statistical significance (Lauer &
Asher 162).

Since none of the variables were statistically significant, they were checked
to see if they approached statistical significance. It was fotmd that one variable,
total niimber of screens, was significant at p= 0.28. The other three scores were

statistically significant in the p= 0.5 to p= 0.6 range. Since these p values are

much higher than the accepted maximum p value of 0.20, it can be safely stated
that these results do not approach statistical significance. Factoring out the nonnative English speaking students fi:om the data did not affect the significance of
the results. Therefore, their presence did not change the results in any systematic
manner.

Even though the responses were not significantly different, it is instructive

to examine the actual mean scores to get a better feel for the students' responses.

In other words, "to see what actually happened." The means of the two groups for
the variable "number of screens traversed" were 135.35 screens for the TOG

browser groups (Standard Deviation of 86.50 screens) and 174.48 for the graphic
browser groups (Standard Deviation of 47.81 screens) (see Figure 4). In
comparison to these results, if a direct path was taken to the place where each of
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the answers could be found, then the average for the variable, total number of
screens, should have been 59 screens. So the browser with the least number of
screen transitions was still twice the optimum.
The means for the second variable, total time taken to answer all ten

questions, were 17.33 minutes (Standard Deviation of 6.58 minutes) for the TOC
groups and 20.19 minutes (Standard Deviation 3.94) for the graphic browser
groups (see Figure 5). Also, there was a weak correlation between the time taken

to answer all of the questions and the total number of screens. The correlation
was .43. This is fairly low, but it is significantly different firom zero.

The accuracy of the answers for each browser was also very close to being
the same. The TOC groups had an accuracy of 61.28% correct answers with
17.24% of the responses indicating that the students gave up and 3.21% of

TOC Total

MAP Total

Figure 4. Means for the variable "total number of
screens"
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Min

TOC

MAP

Figure 5 Means for the variable "total time taken to
answer all ten questions"

the responses indicating the students were not sure if they found what they were
looking for. The standard deviation of the correct, give up, and unsure responses
was 29.19%, 19.22%, and 6.06% respectively (see Figure 6). The graphic browser
groups had an accuracy of 68.89% with 18.10% of the responses indicating that

the student gave up and 3.65% of the responses indicating that the students were
not sure if they foimd what they were looking for. The standard deviations for the
graphic browser groups were 19.67%, 14.02%, and 7.26% respectively. Finally,
the number of browser screens traversed by the TOC group was 28.15 (Standard

deviation of 38.51) and for the graphic browser group it was 26.67 (Standard
deviation of 36.32) (See Figure 7).

46

%

•

TOC

•

MAP

1

%Correct

%GiveUp

%Unsure

Figure 6. Accuracy of each group's answers

28.2

27.4

TOC Total

MAP Total

Figure 7 Means for the variable "total number of
browser screens"
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IV.

DISCUSSION AND CONCLUSIONS

The resiilts of the study need to be reviewed in terms of its piirpose which
was to determine whether novice users of a h5^ertext software user manual found

a graphic style ofbrowser easier to use than a TOC style of browser when they
were asked to perform directed tasks.

The results of the pretest showed that the directed task results should not
have been affected by the composition of the two classes because they were

approximately equal in terms of past experiences with the computer and with
h3rpertext. But even with the pretest demonstrating that the two groups were
equal, the directed task results did not completely fulfill expectations.

Predicted vs. Actual Results

Before the data was collected, the students using the TOC browser were

expected (1) to traverse fewer screens when answering the questions, (2) to take
less time to answer the questions, and (3) to be more accvirate in their answers.
The data collected tentatively supported the first two of the three proposed results
of the study while tentatively contradicting the third proposed result.
In terms of the first expected result, the TOC browser marginally fiilfiUed

the expectations of the study. The TOC browser seemed to be more effective
because the two groups of students using it did manage to perform the directed
task in a smaller number of screen transitions than the two groups of students
that used the graphic browser. But this result was weakened because the
difference between the groups was not statistically significant. Therefore, the

TOC browser was not shown to be clearly superior to the graphic browser when
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the total number of screen transitions for the four groups of students was
compared.

In terms of the second expected result, the TOC browser didn't perform

quite as well as was expected. Even though the two groups of students using the
TOC browser performed better than the two groups of students using the graphic
browser by taking less time to perform the task, the difference between the four
groups wasn't statistically significant. Therefore, the TOC browser was not
shown to be clearly superior to the graphic browser when the total amovint of time
needed to perform the directed task was compared between the four groups of
students.

In terms of the third expected result, the two groups of students that used
the graphic browser performed better than expected in terms of the accuracy of
the subjects' response. But again, this was not a strong difference because it was
not statistically significeint. So the TOC was not shown to be clesirly inferior to
the graphic style of browser when the accuracy of the students' answers to the
questions was compared between the four groups of students that used the
browsers.

Not only were these results not significant, they never came close to
achieving statistical significance. The measured differences between the two

browsers did not achieve statisticed significance until the significance level was
raised to p= 0.28 for the variable, total number of screens that were traversed,

and between p= 0.5 and p= 0.6 for the variables, accuracy of the answers, and
time taken to perform the directed task. These results are well beyond the
maximum of p=.20 that is considered acceptable by many researchers.
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It can be concluded that because of the lack of statistically significant

differences in the performance data, the students used in this study didn't find the
TOC browser to be more useful than the graphic style of browser. The TOC's

similarity to a printed table-of-contents and the graphic browser's greater

complexity apparently did not adversely affect the students* performance. The
implication of this result is that writers and designers of hypertexts may be free to
pick the best browser style in terms of ease of implementation or of stylistic
continuity with the rest of the document.

Some Factors Affecting the Study
While the above conclusion is a valid interpretation of the data, it does not

consider that other factors might have affected the results by decreasing the
differences between the two browsers. This section will examine two possible
factors.

Low browser utilization

The first possible factor that might have affected the results was the low

number of accesses to the browsers. It was surprising to see the low number of
browser screen transitions that were recorded. The browser screen transitions

were responsible for only 21% of the TOC group's total number of screen

transitions and for 15% of the graphic browser group's total number of screen
transitions. In comparison to other studies, Hammond and Allinson reported that
their graphic browser was responsible for 31% of the screen transitions for their

groups that had a graphic style browser as a navigational aid (Extending 298).
Because their browser was used more extensively than were the browsers that
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were created for this study, the students in the current study may not have

perceived these browsers to have been helpful for aiding them with navigation. As
a result, the browsers were under utilized which may have resulted in them having
little effect on the student's performance.

Two implementation issues may have been responsible for the low
utilization of the browsers in this study. The first issue revolves around the

browsers' visibiHty. In this hypertext, the browsers had to be called up with a
button before they were visible. Keeping the browsers out of sight in this fashion
could have discouraged their use, thus diluting their effectiveness as a navigation
tool. Another implementation issue that might have reduced the browsers*
effectiveness was how the browser returned the subjects to the hypertexts' data
screens. Every time the subjects returned from the browsers, they were not
returned to the same spot from which they originally accessed the browser in the

h3T)ertext. They were returned to the introduction screen instead. This forced
them to re-navigate to their original location. As a result, they may have foimd
this featvire to be frustrating and thus ignored the browsers.

Hypertext size

A second factor that might have affected these results is the size of the
hypertext document. A graphic browser created for a document of 70 nodes may
not be sufficiently complex to create a real advantage for the TOC browser. This
speculation is based on the fact that the graphic browser in this study was not as

visually complicated as was expected for a h3T)ertext docviment of that size. A
larger document would increase the mmiber of explicit links that would be shown
in the browser, thus increasing its complexity. Because Conklin's example of a
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highly complex browser represented only 88 nodes, increasing the current studys
hypertext size from 70 to 140 nodes would insure that the document is sufficiently
complex to create an advantage for the TOC browser (Conklin 39).
Further study

In continuing this study's comparison of these two types of browsers, there
are three possible avenues of research that can be pursued. They are (1)
validation of the results, (2) investigation of the impact of different browser

presentation strategies, and (3) investigation of tasks that are best supported by
a browser.

Validation studies

While the initial results of this study indicate that there is no real difference

between the browser styles that were compared, further work needs to be done to
validate these findings for demographic groups that weren't represented by this
study's subjects. Also, care should be taken in extending these findings to other
demographic groups because the subjects in this study were fi:om a very specific
population and are probably not representative of users of computer

documentation as a whole. Therefore, a next step in this line ofinquiry is to
replicate this study with a sample from a more broad based population so that the
findings of this study can be generalized to the average user of computer
docvimentation.

Validation work of this kind is important when using an experimental or

quasi-experimental method because much of these two methodologies* ability to
establish cause and effect stems from the their ability to have resiilts that can be
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replicated. No single experiment or quasi-experimentcan prove or disprove the
hypothesis that it sets out to test. It can only establish that any dififerences
measured by the experimenter are unlikely to be caused only by chance (Edwards

21). But when an experiment has been performed repeatedly, and the results are
essentially the same, then the possibility of the result being due to chance

becomes very small and the h5TDothesis can be considered to be proven (Edwards
21).

Presentation strategies

Also, the impact that different presentation strategies may have on
browser uSe and on the other performance variables needs to investigated further.
As was suggessted in the discussion on low browser utilization, it is possible that
how a browser is integrated into a hypertext is as important or more important

than the t3^e of browser that is used. So a second avenue of investigation would
be to examine what would be the best way to integrate these browsers into the

hypertext. For example, should the browser be presented in a separate window

from the text, or should it be presented in the same window that displays the text.

Browser tasks

A third avenue of investigation is to explore more closely what kind of tasks
are best supported with a browser. The directed task in this study was relatively

simple. What happens if the task becomes more complicated? Will the TOC be
better for simple tasks than for complex tasks? While Hammond and Allinson
have done some discussion on this topic in terms of directed tasks vs. exploratory

tasks, more work needs to be done to provide a detailed picture (Extending 303).
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Like other areas of writing, the problems of authoring hj^ertext documents

are complex and interrelated. The hypertext author needs to know how factors
such as differences in the type of browsers and differences in browser integration

into the hypertext will affect the reader's ability to navigate and utilize the
information within the hypertext document. Without this knowledge, the

hypertext author is reduced to creating effective navigation aids through trial and
error.
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VI,

APPENDIX A: EXAMPLE GRAPHIC BROWSER SCREENS

This appendix shows some of the screens from the graphic browser
that was used in the study.
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HyperteHt B
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VII.

APPENDIX B: EXAMPLE TABLE OF CONTENTS (TOC)
BROWSER

SCREENS

This appendix shows some of the screens from the TOC browser
that was used in the study.
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HyperteHt R
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63

HyperteKt R
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HyperteKt R
55
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Vlll.

APPENDIX C: THE PRETEST

This appendix shows the pretest that was used to establish the
equality of the two classes that were used in the study.

66

User Profile

Please enter the letter of the answer that is most correct between the

brackets. Please pick only one answer imless the question tells you that you can
choose more than one.

[ ] 1. Gender
A. Male
B.

Female

[ ] 2. Classification
A.

Freshman

B. Sophomore

C. Junior

D. Senior

[ ] 3. College
A. Agriculture
B.

Business Administration

C. Design

D. Education

E. Engineering
F. Family and Consumer Sciences
G. Liberal Arts and Sciences

H. Veterinary Medicine

4. What is your major?
(type answer here —>)
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[ ] 5. Is English your first language?
A. Yes
B.

No

[ ] 6. Is English 314 a required course for your degree program?
A. Yes
B. No

[ ] 7. Have you used a microcomputer before this semester?
A. Yes

B. No

[ ] 8. If you answered yes to question 7 (Yes, I have used microcomputers
before), what has been your primary use of microcomputers?
(Please enter into the space between the brackets all choices that apply
to you.)

A. Spreadsheet
B. Word Processing
C. Programming
D. Other

[

] 9. What kind of microcomputer have you used?
(Please enter into the space between the brackets all choices that apply
to you.)

A.

Macintosh

B. MS-DOS

C. Amiga

D. Atari ST

E. Apple n
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[ ] 10. When you registered for this class, did you know that you would be using
Macintosh computers regularly?
A. Yes
B.

No

[ ] 11. If you answered yes to question 10 (Yes, I knew that I would be using
Macintosh computers), did you register for this class because you
knew that you would be working with the computer?
A. Yes
B. No

[ ] 12. Have you used a hypertext system before?
A. Yes
B.

No

C. I don't know

[ ] 13. If you answered yes to question 12 (Yes, I have used a hypertext system),
what did you use it for?

A. Writing

B. Browsing

C. Directed reading
[ ] 14. How often in the past year have you used the hypertext system?
A. Once

B. 1-5 times per week
C. 1-5 times per month
D. 1-5 times per year

[ ] 15. Have you used the program MacDraw II before?
A. Yes
B. No
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[ ] 16. If you answered yes to question 15 (Yes, I have used MacDraw 11), how
often in the past year have you used it?
A. Once

B. 1-5 times per week
C. 1-5 times per month
D. 1-5 times per year
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IX.

APPENDIX D: EXAMPLE DATA SCREENS

This appendix shows some of the data screens from the hypertexts
that were used in the study.
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objects. You selectan object by placingthe
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object's sizeby drvgg^g one of the handles

Tools
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ISi
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MacOrawll menus

TTie Edit Menu

Undo
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This command cancels the effects of the

last action that changed a document. For
example, if you change the size of an
object, and decide the original size fits the
drawingbetter,you choose Undo to
change the objectback to the original size.
You choose Undo ^ m the Edit menu, or

you press Command>Z.

With the Undo command,you can cancel
any actionyou make on an object such as
cutting or pasting,duplicating, resizing,
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Undo worlcs for the last action only,
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the document, you cannot undo the

preceding action. Undo works for actions
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that you perform while editing text as well
as while drawing and editing objects. You
can undo a deletion that you made by
choosingthe Clear command or by
pressing Delete.

cancelled. Afteryou choose Undo, the
command then becomes Redo. Gioosing

You cannot undo actions that don't

command and reinstates the last change to

change the contents of the document, such
as scrolling changing a dialogbox,
selecting a drawing tool or resizing a

window.
The Undo command itself can also be

Redo cancels the previous Undo
the document.

Edit Menu
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X.

APPENDIX E: THE DIRECTED TASK QUESTIONS

This appendix shows the questions that the students had to answer.
The same set of questions was used with both types of browsers.
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1. How many drawings can you open at one time?
A. One
B. Three
C. Seven

D. I gave up looking for the answer.
E. I think I found the right screen, but the text was not clear.

2. Can you fill an object that was created with the freehand drawing tool?
A. Yes
B. No
C. Sometimes

D. I gave up looking for the answer,

E. I think I foimd the right screen, but the text was not clear.

3. Will the text tool allow you to use colored text in a drawing?
A. Yes
B. No
C. Sometimes

D. I gave up looking for the answer.
E. I think I foimd the right screen, but the text was not clear.

4. If you want to draw an object that is oversized, how can you do it?
A. Drag the pointer to the edge of the screen. It will move automatically.
B. Click in the scroll bar on the right side and bottom of the document
window.

C. It cannot be done.

D. I gave up looking for the answer.
E. I think I foimd the right screen, but the text was not clear.

5. If you want to lock the zero point, what menu command do you use?
A. Layout
B. Rulers
C. Pen

D. I gave up looking for the answer.

E. I think I foimd the right screen, but the text was not clear.
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6. How is the Autogrid turned on?
A.
B.
C.
D.

Choose Preferences in the Layout menu.
Choose Page Setup in the File menu.
Choose Turn Autogrid On in the Layout menu.
I gave up looking for the answer.

E. I think I found tJie right screen, but the text was not clear.

7. What is the fourth step in making a row of identical objects?
A. Select Copy from the File menu.

B. Drag the copy of the object to the second position in the intended row of

objects.
C. Use the Cut command to remove the object from the drawing.
D. I gave up looking for the answer.
E. I think I found the right screen, but the text was not clear.
8. Is the revert command reversible?

A. Yes
B. No
C. In some situations

D. I gave up looking for the answer.
E. I think I found the right screen, but the text was not clear.

9. What is the first step in changing the document's size?

A.
B.
C.
D.
E.

Choose Drawing Size from the Layout menu.
Choose Preferences from the Layout menu.
Choose Page Setup from the Edit menu.
I gave up looking for the answer.
I think I foxmd the right screen, but the text was not clear.

10. What kind of shape does the command "Roimd Comers..." work on?
A. Triangle
B. Circle

C. Rectangle
D. I gave up looking for the answer.
E. I think I found the right screen, but the text was not clear.
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XI.

APPENDIX F: THE PROCEDURAL INSTRUCTIONS

This appendix shows the instructions that were given to the
students. This set of instructions guided them through the testing
procedure.
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Hjrpertext B
ID#

Instructions
Introduction

Thank you for taking part in this study. In this session, you will be asked to
perform two tasks. The first task is to answer a user profile. The second task is
to search for information within a hypertext msmual that you will be reading

online.

To insure that the collected data hasn't been influenced by input from me, I can

answer questions only about how to open and close the documents. I can't help

you with any questions about their contents.
The User Profile

While the user profile is not located on "Class Files.," the following instructions will
guide you to it. Once you start answering the user profile, please answer each
question as accurately as possible.
Opening the User Profile

1. Open the folder "Hypertext Study" that is located on the hard drive ofyour
Macintosh.

Inside of this folder is another folder named "Profiles." There are two other files

here that are named "Hypertext A" and "Hypertext B" and a folder named
"Data". You should ignore them for now.

2. Double click on the folder "User Profile" to open it
Inside of this folder you should see the file named "User Profile" and another
folder named "Completed Profiles." The folder completed profile is where your
response wiU be saved.
3. Open the file "User Profile" by double clicking onto it.
This starts the application "Microsoft Word" and opens a document window for
the file. Now you can start answering the questions in the user profile.
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Answering the Questions

Answering each question is approximately a two step process.

1. Position the blinking bar between the brackets that are in front ofthe question.

2. Type the letter ofthe most accurate response into the space between the brackets.
Please try to answer each question as accurately as possible.

Saving and Closing the User Profile

When you are done with answering the questions, you will need to save your
responses to the hard disk. Because the original Oe is locked, you will need to use
the "Save As..." command to save your responses.

1. Select the "Save As..." command from the file menu.
This will bring up the "Save As..." dialog box.

2. Name your file using your id number.
Your ID number is the two digit mmiber that is located in the upper right hand
comer of your instruction sheet. The file name shotdd look like this:
XX.UsrProf. The XX is your two digit ID number. The ".UsrProf' suffix
indicates that the file contains your answers to the questionnaire.
3. Select "Close" from the file menu.
This will close the user profile.
4. Select "Quit " from the file menu.
This will close the application "Microsoft Word" and will return you to the folder
"User Profile"

5. Put your response into the folder "Completed Profile."
The Search Task

After you finish answering the user profile, your next major task is to search for
answers to 10 questions about a drawing program. These questions will be
presented to you inside of the hypertext document.
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Starting the hypertext document

1. Look for the name ofyour assigned hypertext document in the upper right hand
comer ofthese instructions.

It is located over your ID number. Your document's name will either be

"Hj^ertext A" or "Hypertext B."

2. Double click on your hypertext document

Start your hypertext by double-clicking on it. Note: Only the h3T3ertext that
was assigned to you should be on the machine.

Entering your ID Number

The first page of the hypertext will ask for your ID nvmiber.

1. Enter your two digit ID number by clicking in the circles that correspond to each
digit ofyour ID number.

The left hand column is for the tens digit. The right hand colimm is for the ones

digit.

2. Check the ID. Is it the correct ID number?

• If the number is correct, then you should click on the button labeled "done."

Do not click on done until the number is correct. You will not be able
to correct it later.

•If the number is not correct, click on the appropriate numbers.
Answering the Questions

After you have entered your ID number, the hypertext will show its title page for 2
seconds. Then the instnictions for answering the questions will appear.
1. Click on the "continue" button when you are done with each part ofthe
instructions.

2. Follow the instructions when you answer the questions.

WARNING: Be sure that you have answered the question before
clicking on the "Question Answered" button. You can't return to a
question once you go on to the next question.

NOTE; The Compass Button will help you get an overview of the
hypertext.
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The hypertext controls

This section explains the meaning of the buttons that appear on the lower left side
of the hypertext cards (see Figure 1).

The "house" button: This button is used to quit if you decide to leave the hypertext
before you answer all of the questions (see Figure 1).

The "compass" button: Clicking on this button will bring you to the map of the
hypertext. This will help you find information (see Figure 1).
The "pointer" buttons: Clicking on these buttons will allow you to travel between
all of the screens in the hypertext in a sequential fashion. They are best used
for going to the next screen in multi-page nodes. Multi-page nodes contain up
to three pages of information (see Figure 1).

The "Go to Question" button: This button is used to go back to either review or
answer the question that you are currently working on (see Figure 1).
There are additional buttons that will appear on different screens. These buttons
will allow you to travel to the topic that is listed on them.
Also, any bold text in the h3T)ertext is a link to another screen.
HyperteKt fl

Reference
lofl

This section of the manual provides

information about the program's tools
and controls. The following list displays
the features that are found in this section:

This part does not provide step-by-step

explanations forcaiTylngout drawing
procedures. See Basic Procedures
for step by step instructions.

MacDraiii II Tools
MacDraui II Menus

Introduction

Figure 1. An example screen

Go to question
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Quitting

When you are done with the 10th question, the hypertext will automatically close.
•Type "command-Q" to finish quitting firom the document.
K You Run Out of Time

Do not try to answer the rest of the questions quickly. Finish the question that
you are doing and quit. The following instructions will help you in quitting from the
document.

Instructions for Quitting

These instructions are structured to help you quit from giny region of the
hypertext document.
Case 1

If you are in a map or table of contents card.
1. Click one of the topic buttons to go to the body text.
2. Click on the "house" button to quit.
3. Click on "yes" when the h3^ertext asks you if you really want to quit to
H3^erCard.

4. T^e "command-Q" to quit HyperCard.

Case 2

If you are in a question card.

1. Click on the "Look for answer" button.

2. Then click on the "house" button to quit.
3. Click on "yes" when the hj^jertext asks you if you really want to quit to
HyperCard.
4. Type "command-Q" to quit HjrperCard.
Case 3

If you are in the manual text of the hypertext.
1. Click on the "house" button to qioit.

2. Click on "yes" when the hypertext asks you if you really want to quit to
HyperCard.

3. Type "command-Q" to quit HyperCard.
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XII,

APPENDIX G: THE EXIT LETTER

This appendix shows the exit letter that was given to the students
after the study was performed. It explains the piorpose of the study
and it gives the answers to the questions.
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To:

English 314 Students

From:

Mark Satterfield

Subject:
Date:

Department of English Graduate Student
Purpose of H5rpertext Study-

April 8,1992

Purpose of the study
I want to thank you for assisting me with this hypertext study. Your aid has been
invaluable in determining which of two browser styles would be better for users of
on-line computer docimientation. In this case, one browser was made to look like
a map of the document, while the other browser was made to look like a book's
table-of-contents. I am trying to determine if the familiarity of the "table-ofcontents" style helps navigation more than the "map" style. In making this
determination, I will be looking at how the following variables were affected by the
different browsers. These variables are:

• the number of screens that you accessed before answering each question,
•
•
•
•
•

the ntmiber of screens that you accessed for all of the questions,
the id number of each screen that you accessed,
the time taken to find the needed information,
the accuracy of your answers
the nimiber of times you used the browser.

All of these variables measure your ability to place themselves in the document.
Often the case is that the larger the value of each of the variables, the more likely
that you were lost.
In my analysis, I will determine if there are any statistical differences between the
performance of the people who used the different browsers on the basis of the
above variables. I plan to provide you with the tabulated results later in the
semester. If you have any other questions you can call me at the following

number (501) 972-1428.
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Answers to the questions
Here are the ginswers to the questions about the hypertext document.
1. How many drawings can you open at one time?
The answer is: C. Seven

2. Can you fill an object that was created with the freehand drawing tool?
The answer is: A. Yes

3. Will the text tool allow you to use colored text in a drawing?
The answer is: A. Yes

4. If the you want to draw an object that is larger than the screen, how can you do

it?

The answer is: A. When drawing the object, just drag the pointer to the edge of the
screen. The screen moves automatically.
5. If the you want to lock the zero point what command do you use?
The answer is: B. Rulers

6. How is the Autogrid turned on?
C. Choose "Turn Autogrid On" from the Layout Menu

7. What is the fourth step in making a row of identical objects?
The answer is: B. Drag the copy to the second position in the intended row of
objects.

8. Is the revert command reversible?
The answer is: R. No
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9. What is the first step in changing the document's size?
The answer is: A. Choose "Drawing Size" from the Layout menu.

10. What kind of shape does the command "Round Comers,.." work on?
The answer is: C. Rectangle

